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About this Manual 
 
 
 
 
 
 
 
Structure of this 

Manual 

 

 
 
 
 
 
 
 

This manual is divided up into the following chapters: 
 

• Chapter 1 describes how to install Logiscope. 
 

• Chapter 2 describes specific settings for Logiscope on LINUX. 
 

For mode details on license keys and installation, please refer to “Kalimetrix Lifecycle Solutions - 

Licensing Guide”. 

 

Typographical Conventions 

The following typographical conventions are used in this manual: 

 
 

Typeface 

or Symbol 
Meaning 

 
Bold Book titles, important items, and items that you can select, including 

buttons and menus. For example: Click Yes to continue. 
 

Courier Commands, files, and directories; computer output. For example: Edit 

your .properties file. 
 

> A menu choice. For example: Select File > Open. This means select the 

File menu, then select the Open command from it. 
 

 
 

Contacting 

Kalimetrix 

Support 

 

If the self-help resources have not provided a resolution to your problem, you can contact Kalimetrix 

Support for assistance in resolving product issues. 

 
Prerequisites 
 

To submit your problem to Kalimetrix Software Support, you must have an active support 

agreement. 
 

To submit your problem online (from the Kalimetrix Web site) to Kalimetrix Support, you 

must additionally: 

• Be a registered user on the Kalimetrix Software Support Web site. For details about 

registering, go to http://support.kalimetrix.com 

• Be listed as an authorized caller in the service request tool 

http://support.kalimetrix.com/
http://support.kalimetrix.com/
http://support.kalimetrix.com/
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Submitting problems 

To submit your problem to Kalimetrix Software Support: 

1. Determine the business impact of your problem. When you report a problem to 

Kalimetrix, you are asked to supply a severity level. Therefore, you need to understand 

and assess the business impact of the problem that you are reporting. 

Use the following table to determine the severity level. 
 

Severity Description 

 

 
1 

The problem has a critical business impact. You are unable to use the program, 

resulting in a critical impact on operation. This condition requires an immediate 

solution. 

 
2 

The problem has a significantl business impact. The program is usable, but it is 

severely limited. 

 
3 

The problem has a some business impact.The program is usable, but less significant 

features (not critical to operation) are unavailable. 

 
4 

The problem has a minimal business impact.The problem causes little impact on 

operations or a reasonnable circumvention to the problem was implemented. 

 
 

2. Describe your problem and gather background information, When describing a 

problem to Kalimetrix, be as specific as possible. Include all relevant background 

information so that Kalimetrix Support specialists can help you solve the problem 

efficiently. To save time, know the answers to these questions: 

• What software versions were you running when the problem occurred? 

To determine the exact product name and version, use the option applicable to you: 

• Start your product, and click Help > About to see the offering name and 

version number. 

• What is your operating system and version number (including any service 

packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 

symptoms? 

• Can you recreate the problem? If so, what steps do you perform to recreate 

the problem? 

• Did you make any changes to the system? For example, did you make 

changes to the hardware, operating system, networking software, or other 

system components? 

• Are you currently using a workaround for the problem? If so, be prepared to 

describe the workaround when you report the problem. 

3. Submit your problem to Kalimetrix Software Support. You can submit your 

problem to Kalimetrix Software Support goint online to the Kalimetrix Software 

Support Web site at http://support.kalimetrix.com 

https://www.ibm.com/software/rational/support/
https://www.ibm.com/software/rational/support/
https://www.ibm.com/software/rational/support/
https://www.ibm.com/software/rational/support/
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1 Installing Kalimetrix Logiscope 

• Before You Install 
 

• Installing Kalimetrix Logiscope in Windows 
 

• Installing Kalimetrix Logiscope on LINUX 
 

• Start Kalimetrix Logiscope 
 

 
 

Before You Install Administrator privileges required 

For a successful installation of Kalimetrix Logiscope, you must have access to a computer account 

with system administrator privileges. 

 

About license keys and installation 

Depending on your type of license agreement, the license information may already have been 

delivered to you by e-mail. If you are a new user and this is your first license agreement that is 

probably not the case. 
 

During installation, it is assumed that you have the license information at hand, at least hostname and 

port number. You may add the license information later and do not need to install again. 

 
 
 
 

Installing 

Kalimetrix 

Logiscope in 

Windows 

 

 
 

 
Install Kalimetrix Logiscope in Windows 

1. Log on as administrator or make sure that you have administrative privileges. 
 

2. Exit all running Windows programs. 
 

3. Double-click KalimetrixLogiscope-X.exe. 
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Installing 

Kalimetrix 

Logiscope on 

LINUX 

Install Kalimetrix Logiscope on LINUX 

1. Log on to the LINUX host on which you want to install Kalimetrix Logiscope. 
 

2. Unzip the KalimetrixLogiscope2014-1.tgz file. 
 

3. Execute the installation script from the directory Logiscope/Linux: 
 

$ ./tauinst.cd [TODO] 
 

The installation script will start and guide you through the rest of the setup. 
 

License environment on LINUX 

During installation, you will be asked for the license server and port number used. The entered 

information is verified and if a valid license is found a file license.dat is created in the installation 

directory. This file defines the license environment for Logiscope such that any user can start 

Logiscope directly without setting any license environment variables. 

If the servername and/or port number is not available or the license cannot be verified a file 

license.txt will be created in the installation directory. Once you have the correct information replace 

servername and port number in this file with the real values and rename the file to license.dat. 

 

Set up printers and windows appearance on LINUX (optional) 

Before you start using Logiscope on LINUX, you may want to set up PostScript printers. It is also 

possible to set up the appearance of the windows used by Logiscope (this can also be done later on). 

Printers and window appearances are set up by using the Control Panel that is supplied with 

Logiscope. Refer to “Control Panel” on page 5. 

 

 

Client Setup   

Define license environment 

    

 

Every computer running Logiscope must define the environment variable KLS_LICENSE to 

<port>@<server>. 

   

For example, if klsServer is running on the same computer as Kalimetrix Logiscope, 

KLS_LICENSE must be defined to 6309@localhost. 

 
 
 
 

Start Kalimetrix 

Logiscope 
 
Start Kalimetrix Logiscope in Windows 

Start Kalimetrix Logiscope from the Start menu. In the Programs submenu, select Kalimetrix and 

then Kalimetrix Logiscope 2014. 

 
Start Kalimetrix Logiscope on LINUX 

After the environment is set up, start Kalimetrix Logiscope by typing the full path name: 
 

<installation path>/bin/vcs 
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2 Setting up Logiscope on Linux 

This chapter contains information about how to set up your Linux environment for Logiscope. 
 

• Logiscope and MainWin 
 

• Control Panel 
 

• Floating toolbars 

 

 
Logiscope 

and MainWin 

 

Logiscope on Linux platforms uses a third-party software, MainWin, that provides access to the 

Win32 API on Linux environments. Hence, through MainWin, Logiscope is given a nearly identical 

behavior and look-and-feel on LINUX as on Windows, the exceptions being described in “Control 

Panel” on page 5 and “Floating toolbars” on page 9. 
 

Registry The subset of the Windows Registry that is required for applications that use MainWin to run (such 

as Logiscope) is, although available to the end user through the regedit application, not intended 

to be modified. 
 

Note: Do not, unless specifically instructed to do so, modify or remove any Registry keys. 

Otherwise it may result into a corrupt installation of Logiscope. 
 

 
 

Control Panel The Control Panel (implemented by MainWin) is available with Logiscope for the users’ 

convenience. It contains a collection of utilities that allow to set up properties in a similar fashion as 

would have been done in a Windows environment. 

 
 

 
 

Figure 1: The Control Panel 
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Starting the control panel 

The Control Panel is started with the command: mwcontrol (mwcontrol is located in the 

bin directory of your Logiscope installation). 
 

This command opens a window holding icons that have an appearance and functionality similar to 

their equivalence in the Windows Control Panel. 
 

Only the Printers and Display settings are meaningful to use in the context of Logiscope. 

 

Setting the appearance of Logiscope windows 

The Display applet implements a subset of the Windows Display Properties. Use the Display applet 

should you want to configure the appearance of the windows used by Logiscope applications (such 

windows font size and family, colors and sizes of menu bars, scrollbars and buttons etc.) 

 
 
 

 
 

Figure 2: Setting the appearance of Logiscope 
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When you make changes using the Display applet, the changes only affect Logiscope sessions that 

you start after you have saved the Display changes. Logiscope sessions that were running when you 

changed the Display must be restarted for your changes to take effect. 
 

Note: The Display Properties does not affect your Linux desktop. Neither does it impact the 

color, spacing and font properties used for diagrams managed by Logiscope – to change 

such properties, use the Options command from the Tools menu in Logiscope. 

 

Setting up printers 

The Printers applet is similar to the Windows Printers applet. However, unlike Windows, when 

setting up a printer you do not map an actual printer for use with Logiscope. Instead, you map a print 

request to a proper print command on your Linux host. Thus, the procedure for adding new print 

capabilities differs slightly from that on Windows. 

 
 
 

 
 

Figure 3: Setting up printers 
 

 
 
 

 
PostScript printer 

description files 

Note: Changes made using the Printers applet affect Logiscope sessions running on the same 

machine as soon as you save the changes. Instances of Logiscope running on other 

machines must be restarted for the changes to take effect. 

 
PostScript Printer Description (PPD) files describe how to use features that are special for a specific 

PostScript printer. So, to take advantage of your printer's specific features – for example, duplex 

printing or paper tray selection – you need a PPD file. Most printer vendors provide PPD files for 

their printers. For your convenience, a large subset of the PPD files that are included with Windows 

is supplied with Logiscope. In addition, a PPD file for generic PostScript printers, which should 

allow you to print on any PostScript printer, is also provided. 

The Printers applet also includes an “Add New Printer” wizard, described below. 
 

Note: If you already have a printer installed with an application that uses a previous version of 

Mainwin, then you do not need to add the same printer again. The Printers applet now 

includes an option, from the Tools menu, to import existing printers. The imported 

printers will be associated with a default PPD file, and may not access all the printer's 

features. 
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Add New Printer 1.   Start by launching the Control Panel (by typing the mwcontrol command) and double-click 

Printers. 
 

2. Double-click Add New Printer to start the Add New Printer wizard. 
 

• At any time, the Add New Printer can be browsed back and forward using the Next and 

Back buttons. 

3. Click Next to specify the LINUX printer of your choice. 
 

• A list of the printers defined on the LINUX host appears at the bottom of the dialog, along 

with their descriptions. The list of printers is extracted from the /etc/printcap file, 

which contains a list of all printers on the network to which your LINUX host has access. 

The printcap file is used on all LINUX platforms as the central location for specifying 

printers. It is configured and maintained by the system administrator. 

• If the printer you want to add is on the list, simply select it. 

• To add a printer that does not appear on the list, type the LINUX name of the printer in 

the LINUX printer text input field. 
 

4. Click Next in order to specify the default Print Command for the selected printer. 
 

• Usually, the default command is the one you should use. You should ask your system 

administrator before changing this command. 

• If you manually added a LINUX name of a printer in the previous step, the print 

command will automatically use that name. 

5. Click Next to specify the manufacturer and model of your printer, and the appropriate PPD file 

to use. 

• If you have your own PPD file, then click Choose File to locate your PPD file. After 

specifying the name and location of the file (using full path name), click OK. 

• You must either have write permission to the directory $MWHOME/system/ppd, or you 

must set the MWPPD_DIR environment variable to a directory to which you have write 

permission. 

• If you do not select anything in the Choose PPD File page, then a default generic PPD file is 

automatically selected. 
 

6. Click Next, which allows you to specify a printer name and description of your own. 
 

• The Add New Printer wizard provides a default printer name, which you may modify in the 

Printer Name text box. 

• The Printer Description text box has the same functionality as on Microsoft Windows. This 

field may be left blank. 

7. Click Next and decide whether you want this printer to be your default printer. 
 

• This Default Printer page will not appear in the wizard if this is the first printer you are 

setting up. First when adding another printer, then you will be provided the option to 

choose your default printer. 
 

8. Click Next. Now the wizard asks you if you want to print a test page – like in Windows – that 

supplies you with various information, such as the features of the added printer. 
 

9. Click Next and verify that the information you specified in the Add New Printer wizard is 

correct. 
 

• If you are satisfied with the settings, click Finish. 
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• Otherwise, click Back to change the settings. 

The printer you added now appears in the Printers applet, among the previously added printers. 
 

 
 

Floating toolbars When running Logiscope applications that have floating toolbars, such toolbars behave differently 

on LINUX from their behavior on Windows. 
 

Behavior on Windows Behavior on LINUX 

Double-clicking the title bar of a floating 

toolbar window returns the toolbar to its 

original position on the application's window, 

below the menu bar. 

Double-clicking the title bar of a floating 

toolbar window does not do anything. To 

return the toolbar to its location on the 

application window, click the window system 

menu at the top left corner of the toolbar 

window and select Redock. 

When dragging a floating toolbar window over 

the toolbar area of the application window, a 

rectangle appears to indicate what the size and 

location of the toolbar would be should it be 

dropped in that position. 

When dragging a floating toolbar window over 

the toolbar area of the application window, no 

rectangle appears to indicate the size and 

location of the toolbar in its place on the 

application window. Instead, the floating 

toolbar is dragged. When dropped, the toolbar 

is correctly placed inside the application's 

window. 
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3 Installing License Server on Linux 

This chapter contains information about how to set up your Linux license server environment for 
Logiscope. 

 

• Server Installation 
 

 

 
Server 

Installation 

 

The Kalimetrix License Server may be started from the command line or with the start_kls script.   

You will have to open the firewall(s), so that the computer running klsServer 

 

 

Installation from the command line 
 

usage: klsServer [-l logFile] [-p port] -f licenseFile1 [-f 

licenseFile2...] 

   

Default port is 6309. 

Default log is standard error. 

 

Installation with the start_kls script 
 

Copy your license file in the directory of klsServer, as Logiscope.lic 

Run sh start_kls (or csh depending on your Linux OS type) 

The log file is kls.log in the same directory. 

 

If you want klsServer to listen on another port, write to another log file or read another license file, 

edit start_kls and change the lines: 

KLS_LIC=Logiscope.lic 

KLS_PORT=6309 

KLS_LOG=kls.log 
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4 Installing License Server on Windows 

This chapter contains information about how to set up your windows license server environment for 
Logiscope. 

 

• Server Installation 

 
 

Server 

Installation 

 

The Kalimetrix License Server may be started from the command line or as a MS Windows service. 

 

In both cases, you will have to open the firewall(s), so that the computer running klsServer.exe 

can be contacted at the choosen TCP port. 

 

From the command line 
 

usage: klsServer.exe [-l logFile] [-p port] -f licenseFile1 [-f 

licenseFile2...] 

 

 Default port is 6309. 

 Default log is standard error.  

 

As a MS Windows service 
 

You must have Administrator acces rights for this procedure. 

 

Copy your license file in the directory of klsServer.exe, as Logiscope.lic 

 

Run KLS_Install.bat: 

MS Windows XP: double click on KLS_Install.bat 

MS Windows 7: right click on KLS_Install.bat and select run as Administrator 

 

The log file is kls.log in the same directory. 

 

If you want klsServer to listen on another port, write to another log file or read another license file, 

edit KLS_Install.bat and change the lines: 

set KLS_LIC=Logiscope.lic 

set KLS_PORT=6309 

set KLS_LOG=kls.log 

 

To uninstall the service, run KLS_Uninstall.bat: 

MS Windows XP: double click on KLS_Uninstall.bat. Ignore the error message saying that the 

program was left running. 

MS Windows 7: right click on KLS_Uninstall.bat and select run as Administrator 
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© Copyright 2014 

The licensed program described in this document 

and all licensed material available for it are provided 

by Kalimetrix under terms of the Kalimetrix 

Customer Agreement, Kalimetrix International 

Program License Agreement or any equivalent 

agreement between us. 

Any performance data contained herein was determined 

in a controlled environment. Therefore, the results 

obtained in other operating environments may vary 

significantly. Some measurements may have been made 

on development-level systems and there is no guarantee 

that these measurements will be the same on generally 

available systems. Furthermore, some measurements 

may have been estimated through extrapolation. Actual 

results may vary. Users of this document should verify 

the applicable data for their specific environment. 

Information concerning non-Kalimetrix products was 

obtained from the suppliers of those products, their 

published announcements or other publicly available 

sources. Kalimetrix has not tested those products and 

cannot confirm the accuracy of performance, 

compatibility or any other claims related to 

non-Kalimetrix products. Questions on the capabilities 

of non-Kalimetrix products should be addressed to the 

suppliers of those products. 

This information contains examples of data and reports 

used in daily business operations. To illustrate them as 

completely as possible, the examples include the names 

of individuals, companies, brands, and products. All of 

these names are fictitious and any similarity to the 



 

 
 

names and addresses used by an actual business 

enterprise is entirely coincidental. 

If you are viewing this information softcopy, the 

photographs and color illustrations may not appear. 
 

 
 

Copyright license 
 

This information contains sample application 

programs in source language, which illustrate 

programming techniques on various operating 

platforms. You may copy, modify, and distribute 

these sample programs in any form without 

payment to Kalimetrix, for the purposes of 

developing, using, marketing or distributing 

application programs conforming to the application 

programming interface for the operating platform 

for which the sample programs are written. These 

examples have not been thoroughly tested under all 

conditions. Kalimetrix, therefore, cannot guarantee 

or imply reliability, serviceability, or function of 

these programs. 

Each copy or any portion of these sample programs or 

any derivative work, must include a copyright notice as 

follows: 

© (your company name) (year). Portions of this code 

are derived from Kalimetrix Corp. Sample Programs. 

© Copyright Kalimetrix Corp. _enter the year or 

years_. 
 

 
 

Trademarks 
 

Kalimetrix, the Kalimetrix logo, Kalimetrix.com are 

trademarks or registered trademarks of Kalimetrix, 

registered  in  many  jurisdictions  worldwide.  Other 
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product and services names might be trademarks of 

Kalimetrix or other companies. 
 

 
Adobe, the Adobe logo, Acrobat, the Acrobat logo, 

FrameMaker, and PostScript are trademarks of Adobe 

Systems Incorporated or its subsidiaries and may be 

registered in certain jurisdictions. 

AIX and Informix are trademarks or registered 

trademarks of International Business Machines 

Corporation in the United States, other countries, or 

both. 

HP and HP-UX are registered trademarks of 

Hewlett-Packard Corporation. 

Java and all Java-based trademarks and logos are 

trademarks of Sun Microsystems, Inc. in the United 

States, other countries, or both. 

Linux is a trademark of Linus Torvalds in the United 

States, other countries, or both. 

Macrovision and FLEXnet are registered trademarks or 

trademarks of Macrovision Corporation. 
 

Microsoft, Windows, Windows 2003, Windows XP, 

Windows Vista and/or other Microsoft products 

referenced herein are either trademarks or registered 

trademarks of Microsoft Corporation. 
 

Netscape and Netscape Enterprise Server are registered 

trademarks of Netscape Communications Corporation 

in the United States and other countries. 

Sun, Sun Microsystems, Solaris, and Java are 

trademarks or registered trademarks of Sun 

Microsystems, Inc. in the United States and other 

countries. 

Pentium is a trademark of Intel Corporation. 

ITIL is a registered trademark, and a registered 

community trademark of the Office of Government 



 

 
Commerce, and is registered in the U.S Patent and 

Trademark Office. 

LINUX is a registered trademark of The Open Group 

in the United States and other countries. 

Other company, product or service names may be 

trademarks or service marks of others. 
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